Dreamweaver Handout
University of Connecticut
Prof. Kent Golden
Kent@GoldenMultimedia.com
www.GoldenMultimedia.com
Main goal of this handout: To give you the steps needed to create a basic personal website using
Dreamweaver.
Your website can contain any additional information that you would like to include, but should
contain the following pages and elements:
1. A main page (called index.html)
a. A picture of you (with rollover text of your name)
b. Your contact information
i. Your name (in larger font)
ii. Email address (as a hyperlink)
iii. Phone number or mailbox (optional)
iv. Instant Messenger screenname
c. “About me” text (where you are from, your program of study, etc.)
d. A UConn logo that links to www.Uconn.edu
2. A page to keep track of your “Online Learning Master Skills” (called
skills.html)
a. The list of the skills from Dr. Young
b. Text/graphic to show if you have completed the item or not
c. “Proof” of an item’s completion (like a screenshot of a text
message conversation, or link to a document)
3. A media page (called media.html)
a. A link to a sound recording (use samples or a sound file from the
web)
b. An embedded Flash animation (I will provide some for you)
c. An embedded Quicktime movie (I will provide some for you)
4. A link page (called links.html)
a. A link to the directory of other student’s websites
b. Include a few links to websites you like
5. Buttons to link to every page
a. Should be visible on all pages
b. Should show the visitor what page they are on (i.e. they should
look “pressed” on the current page)
Extra Items
Once the basic requirements have been met, you are free to customize your website to your own
liking. You can insert picture of friends, your car, pets, etc,) Companies like Yahoo! provide lots of
features you can also include in your site.
Here are some other items that you may want to try:
1. A “hit” counter that visitors can see
2. An interactive map and/or directions to get to Uconn
3. The current Date
4. A guestbook or feedback form
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How to create a new website in Dreamweaver
Step 1: Basic Site setup
1. If you are using your own computer, you must first map a network drive to the server:
a. Make sure you are connected to the network and can access the internet.
b. Mac users: follow the steps on the additional handout.
c. PC users: Click the “Start” button in the lower left corner of your screen and look for
“My Computer”. Put your cursor over the icon and *rightclick*.
d. From the menu that appears, choose “Map Network Drive”
e. In the box that appears, you can leave the “Drive Letter” asis, and click into the box
for “Folder”. Type the following address:
\\Nsoeweb2\EPSY343\students
f. Click the “Finish” button.
g. You will be prompted for a username and password. Enter the following:
Username: UCONN\netID
Password: your password
h. This will create a drive mapping to the server (where your website files will
eventually go), and allow you to access it easily when you browse for files in “My
Computer”
i. Doubleclick the folder that has your netID (like “kbg05003”) and you should see 3
folders called “documents”, “images” and “media”.
2. To copy the graphics and other elements you will need from the server to your local
computer:
a. When you are in your netID folder and can see the 3 folders, click the “Edit” menu
option at the top of the window, and then choose “Select All” to highlight everything.
b. Then move your mouse cursor over the highlighted folders and *rightclick*.
c. From the menu that appears, choose “Cut”. (The folders are now in the Windows
clipboard).
d. Click the “Start” button, and then click “My Documents”
e. In the My Documents folder, move your mouse to an empty area and *rightclick*.
f. From the menu that appears, choose “New”, and then “Folder”.
g. While the text “New Folder” is highlighted, type a new name of “My EPSY343
website” and then click on a blank area to set the name.
h. Open the folder you just created, and *right*click in a blank area.
i. On the menu that appears, choose “paste”. The folders from the server will be moved
from the Windows clipboard into this folder (it will take a minute or two).
3. If you have any additional graphics, animations, etc. that you want on your site, they need to
go into the appropriate local folders:
a. Copy and paste any pictures and buttons you want into the local “images folder”.
b. Copy and Paste any documents (pdfs, Word docs) into the local “documents” folder.
c. Copy and paste any other media (sounds, Flash animations, QT movies) into the local
“media” folder.
4. Open Dreamweaver
a. If it is not on the desktop, click the “Start” button, then go to “All
Programs”, and look for “Macromedia”. Inside that menu should be
Dreamweaver.
5. When you open Dreamweaver, you may see a “Site Definition” wizard
appear that asks you to name your site. If you do, go to Step 5. If you
don’t:
a. Click the menu option “Site” at the top of the screen, and then “Manage Sites”.
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b. Click the button “New”
c. Choose “Site” and the “Site Definition” window should appear.
6. Make sure you are on the “basic” tab, and type in a name for your website (example:
“Kent’s EPSY343 website”)
7. Click the Next button.
8. Make sure “No, I don’t want to use a server technology” is selected, and click “Next”.
9. Make sure the first option “Edit local copies on my machine, then upload to server when
ready” is checked.
10. Where it asks “Where on your computer do you want to store your files?”, click the small
graphic of a folder.
11. Browse to the folder we created: “My EPSY343 website” and click the “select” button.
12. Click the Next button.
13. Where it asks “How do you connect to your remote server?”, choose “Local/Network”.
14. Where it asks “What folder on your server do you want to store your files in?”, click the
small graphic of a folder.
15. Browse to the mapped drive we created: \\Nsoeweb2\EPSY343\students, and then double
click the folder with your netID.
16. Once inside your netID folder, click the “Select” button.
17. Click “Next”
18. Make sure the option for “No, do not enable checkin and checkout” is selected, and then
click “Next”.
19. A confirmation screen will appear showing your basic settings. Now click the tab at the top
labeled “Advanced”.
20. Click “Local Info” on the left.
21. On the right, find the box that says “default images folder” and click the folder next to it.
22. Browse to the local folder called “images” (inside your “My EPSY343 website” folder) and
once you are looking at the contents of the image folder, click “Select”.
23. Click the “Done” button.
24. Click the “Done” button again.
25. You have now completed the basic setup for your files. On the right side of the screen, you
should now see your folders. “Local View” shows the files that exist on your local computer
(in your “My Documents” folder), and “Remote View” shows you the files that exist on the
server (In your netID folder).
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Step 2: Creating your index.html page
First we will create the index page placeholder, and then later we will go back and make it look how
we want.
1.
2.
3.
4.
5.
6.
7.
8.

Click the “File” menu option at the top of the page.
Choose “New”
Under “Category”, click “Basic Page”.
On the right, click “HTML”
Click the “Create” button. We now have a blank HTML document.
Type “This is the index.html page” in the document (just as you would in a Word processor).
Click the “File” menu option, and choose “save as”
If you are not there already, browse to the local “My EPSY343 website” folder we created
(so you see “documents”, “images” and “media”).
9. Highlight the text “Untitled1.htm” and delete it.
10. Type in the name: index.html
11. Click “save”.
12. Note that on the right side of the screen, you can now see the file “index.html” under your
folders.
13. Click the small grey X in the upper right of the document to close it (not the red X that closes
Dreamweaver):

Step 2: Creating your other pages
Now we will create the other html pages that we need. Note that these pages will only be
placeholders. Later we will overwrite them with our finished index.html page and edit them with
our content.
1. On the right side of the screen (where you can see your folders), put your mouse cursor over
the file “index.html” and *right*click over it. A small menu will appear.
2. Move your cursor over “edit”, then click on “duplicate”. Another file will appear with the
name “Copy of index.html”
3. *Right*click on the file “Copy of index.html” and move your cursor over “edit”. Click
“rename”.
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4. The filename will now be highlighted, and you can type a new name. Type the name
skills.html and when done, move your cursor to a blank area of the window and leftclick to
set the name.
5. Doubleclick on the file “skills.html” to open it.
6. Change the text to say “This is the skills.html page”.
7. Go back to step #1 above and repeat this procedure to create two other html files called
“media.html” and “links.html”. Change the descriptive text in each file so they are easier to
keep track of (“This is the media.html or links.html page”).
8. When complete, you should have 4 html files:

Step 3: Editing your index.html page
Now we can go into our index.html page and make it look like a real webpage.
1. Doubleclick on the file “index.html” to open it.
2. Highlight the text “This is the index.html page” and delete it.
3. Type in your name, email address, phone number, and Instant Messenger screen name (each
on their own line).
4. Below your contact information, type the text “About me”, and then a brief description of the
degree you are pursuing, where you are from, etc.
5. To change the size (or other aspect) of your text:
a. Highlight the text that you want to change (such as your name)
b. At the bottom of the screen, click the “Size” pulldown menu and select a size, such as
18 (default is 16).
c. You can also change the color of your text, or make it Bold or Italic.
d. Dreamweaver also gives you other formatting options that may be familiar to Word
processor users:
i.
ii.
iii.
iv.

Aligns your text on the left side of the page
Aligns your text in the center of the page
Aligns your text on the right side of the page
Creates a bulleted list

v.
Creates a numbered list
vi.
Indents your text
vii.
Removes an indent (or “outdents” your text)
6. Highlight the “About me” text and make it bold.
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7. To change the name of your page (as it appears in a visitor’s browser):
a. Click in the box at the top of the screen labeled “Title” and enter your title. (example:
“Kent Golden – Home”, “Kent Golden – Skills”, etc.)

8. To make your email address into a hyperlink that visitors can click:
a. Highlight the text of your email address
b. At the bottom of the screen, click in the box labeled “Link”
c. Type “mailto:” and then your email address (no spaces)

d. Then click in a blank area of the page to set it. Your email address will now be
underlined, meaning it is a link that can be clicked. When a visitor clicks it, their
default email program will open up, and your email address will automatically be
placed in the “To” box.
9. To insert a picture (of yourself):
a. Click in your document before your name, and hit the return or enter key to move it
down a line.
b. Click in the blank line above your name.
c. Click the menu item “Insert”, and then “Image”.
d. Browse to your local “images” folder (in “My EPSY343 website”) and highlight the
picture you want.
e. Make sure the box for “Relative to:” has “Document” in it.
f. Click “OK”, and the picture will appear in your page.
10. To create “rollover text” for an image:
a. Click the picture in your document to highlight it.
b. At the bottom of the page, click in the box labeled “Alt” (short for “alternate text”),
and type the text you want to appear when a visitor’s cursor pauses over the picture
(i.e. “Hi, I’m Kent Golden”):
11. To have your text wrap around your
picture:
a. Click the picture in your document to
highlight it.
b. At the bottom of the page, click the
arrow next to the box labeled
“Align”, and choose “Left”.
c. You can also choose “Right” if you
want your picture on the right side of
the screen.
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12. If you haven’t done so recently, click “File” and then “Save” to save your document. Save
often!
13. To test your page and see what it would look like on the internet:
a. Save your document (“File”, “save”)
b. At the top of the page, click the small globe, then choose “Preview in IExplore”.

14. To insert a table (to arrange all of the elements of your page):
a. Click before your picture and hit the “return” or “enter” key to move your picture
down.
b. Click in the blank line above your picture.
c. Click “Insert”, and then choose “Table”. A window will appear where you can
change some options.
d. In the “Rows” box, enter the number 1
e. In the Columns box, enter the number 4
f. In the “Table Width” box, enter the number 723
g. Click OK, and your table will be inserted into your document.
h. Highlight the table by moving your cursor over the top line until a small grid appears,
then click.
i. At the bottom of the screen, click the arrow next to “Align” and choose “Center”.
This will put your table and everything in it into the center of the screen.
j. Now highlight all of your content that you created (your picture and all of your text).
k. Move your cursor over part of the highlighted content, and then click and hold your
mouse button.
l. Move your cursor into the 3rd empty cell of the table and release the button. This will
move all of the highlighted text into that cell.

15. To create a navigation bar for your buttons:
a. Click in the cell that is furthest to the left.
b. Click “Insert”, and then choose “Image Objects”, and “Navigation Bar”
c. In the box for “Element Name” type: “home”. This is the name of the first button
that we are creating.
d. Where it says “Up Image”, click the “Browse” button.
e. Browse to the local “images” folder and locate the graphic that you want to show
when the Home button is “Up”, or not pressed (example: button_blue_home.jpg)
f. Where it says “Over Image”, click the “Browse” button.
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g. Browse to the graphic you want to show when the visitor places their cursor over the
button (example: button_green_home.jpg)
h. For “Down Image” and “Over while down”, browse to the same file you chose for
your “Over Image” (button_green_home.jpg). This will be the graphic that shows
after the visitor has clicked the button and they are brought to the new page.
i. In the “Alternate Text” box, type the rollover text that you would like to appear when
a visitor moves their cursor over the button (i.e. “Click here to visit my Home page”).
j. Next to the box that says “When clicked, go to URL”, click the “Browse” button.
k. Browse to your local “My EPSY343 website” folder, and choose the file
“index.html”.
l. Next to that “Browse” button where it says “in”, make sure that “Main Window” is
selected.
m. Make sure the box for “Preload images” is checked.
n. Next to where it says “Insert”, change it to say “Vertically” so your buttons will line
up on the side of the page (instead of across the top).
o. Make sure that the box for “Show ‘Down image’ initially” is checked. This make the
Home button show the “pressed” color you chose, which lets them know that it is the
current page.
p. Click the + button at the top of the window to add another
button:

q. Where it says “Element Name”, type the name of your second button (i.e. “Skills”)
r. Go back to step “d” above and repeat the process for each one of your buttons (Skills,
Media, and Links).
s. For your other buttons (on the index.html page), make sure the “Show ‘Down image
initially” box is not checked.
t. When finished adding buttons, click the OK button, and your navigation bar with
buttons will be added to your page.
u. Save your page (“File”, “save”)
v. Preview your buttons in Internet Explorer (press the globe, then “Preview in
iexplore”).
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w. Note: If you have Windows SP2 installed, you may get a message at the top of your
browser that says “To help protect your security, Internet Explorer has restricted…”
This will prevent your buttons from changing color when you move your cursor over
them (javascript). This will not happen to your visitors when you publish the site, but
to get around this in the meantime:
i. Click the bar where the security message is
ii. Click “Allow Blocked Content”
iii. Click “Yes” to the confirmation message.
x. From your main page you should be able to click and get to any of your other pages.
Note that since we haven’t put any buttons on your other pages yet, you will have to
use the browser’s “Back” button to return to the Main Page.
y. If you need to go back and make any changes to your navigation bar (or
buttons), there is a different way to access it:
i. Click the “Modify” menu item
ii. Click “Navigation bar”
iii. You can then change any aspect of the Navigation bar.
iv. If you want to change the order of how the buttons appear on your page,
you can highlight the name of the button in the “Elements” window, then use
the up and down buttons to move them around.
16. To add the linked UConn graphic above your buttons:
a. Click in the cell where your buttons are, and use the arrows on your keyboard to get
the flashing cursor to the left of the buttons.
b. Hit the “return” or “enter” key on your keyboard to bump the buttons down a line.
c. Click in the empty line above the buttons
d. Insert the Uconn logo by following the normal steps for inserting a picture.
e. Click the logo to highlight it
f. At the bottom of the screen, click in the box labeled “Link” and type in the full
internet address (URL) of UConn: http://www.uconn.edu (Note: the same
procedure can be applied to highlighted text to make it into a hyperlink)
g. Click in the “Alt” box and enter the text: “Click here to visit the UConn website”

17. To move your UConn logo and buttons to the top of the screen:
a. Click below your buttons in a blank part of the cell.
b. At the bottom of the screen, click the arrow next to where it says “Vert”, and then
choose “Top”.
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18. To change the background color of your cells:
a. Click in the cell that you want to change.
b. Click the small box labeled “BG” to change the color of the background.
c. Or, click the folder next to the text box labeled “BG” to choose a picture that will be
tiled as the background (use only if you have a picture that will not be distracting).
d. Repeat for all of the cells that you want color in.

19. (Optional) To add more cells to your table (to create colored lines, to rearrange
pictures, or to create empty space):
a. Click in the existing cell where you would like the new cell.
b. *right*click and move your cursor to “Table”, then choose “Split cell”
c. Choose whether you want to split the cell into 2 rows (horizontal) or columns
(vertical).
d. A new cell will appear (it will probably be small and hard to see at first).
e. Highlight and drag your content into the new cell (if desired).
f. Click in the cell and set the background color (if desired).
g. You can also move the cell walls by moving your mouse cursor over the line you
want to move, then clicking and dragging until it is in the desired space.
h. Note: If a cell wall won’t move where you want, check to see if there are any blank
lines of text in the cell that are stopping the move.
20. To insert spacers to move your pictures, text, and borders:
a. Click in the cell where you need the spacer (like an empty cell that is being used for a
border).
b. Click “Insert” and “Image”.
c. Browse for the spacer in your “images” folder that matches your background color
(so it will be invisible) and insert it.
d. Once the spacer is in the document, you can resize it by moving your mouse cursor
near one of the edges of the graphic, and then clicking and dragging to the desired
size.
e. You can also highlight the spacer, and then change the numbers in the “W” and “H”
boxes at the bottom of the screen to change the graphic size.
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21. To upload your website files from your local computer to the remote server (when you
are done editing it):
a. Open the file index.html.
b. Click the “Site” menu at the top of the screen.
c. Click “Put”
d. A window will appear asking if you want to include dependant files. Choose “Yes”
so that all of the graphics and elements will also be copied to the server.
e. Note: In the future, if all of your graphics are already on the server and you only
made a change to the html page (like a spelling change), you can choose not to
include dependant files.
f. Note: An alternate way to upload files from your computer is to find the file on the
right side of your screen (where you see your folders), and *right*click it. You can
then choose “Put” from the menu that appears. This is useful if you want to upload a
picture that you edited, or a bunch of files at once.
g. This process must be repeated for every page you create, and must be repeated
whenever you make future changes to your website.

Step 4: Copying your index.html page to your other pages
This step is crucial in saving you a lot of time, and making sure that all of your pages have the same
look and feel (including your buttons).
1. Close out of the index.html page (if it is open).
2. On the right side of the screen (where you can see your folders), move your mouse cursor
over the file “skills.html” and *right*click.
3. From the menu that appears, select “Edit”, and then “Rename”.
4. add the letters “old” to the end of the name (i.e. “skillsold.html”)
5. When you click in a blank area to set the name, a window will popup asking if you want to
update the links contained in your project. Make sure you select “Don’t Update”.
6. Leaving index.html as it is, repeat this procedure and rename all of the rest of your files with
the “old” addition.
7. On the right side of the screen (where you can see your folders), move your mouse cursor
over the file “index.html” and *right*click.
8. From the menu that appears, select “Edit”, and then “Duplicate”.
9. A new file called “Copy of index.html” will appear.
10. Rename the new file as “skills.html”
11. Duplicate your index.html file repeatedly until you have a new set of files to replace the old
ones (skills.html, media.html, and links.html)
12. *Right*click each of the old files (i.e. “skillsold.html”) and choose “edit”, then “delete” to
delete them.
13. Now you can go into each of the new files and make the changes needed so that they have
the content you want.

Step 5: Editing the Skills page
Now that our skills.html page is an exact copy of our index.html page, we can edit this page so that it
has our “Skills” content, and the overall look and feel will remain the same.
1. To rename the skills page’s title:
a. Doubleclick the file skills.html to open it.
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b. At the top of the page, change the title to reflect the current page (i.e. “Kent Golden –
Skills”)
2. To make the “home” button look not pressed, and to make the “skills” button looked
pressed (when a visitor is on the skills page):
a. Click the menu option for “Modify” and choose “Navigation Bar”
b. In the “Elements” box, click the name “home” to select it.
c. At the bottom of the window, uncheck the box for “Show ‘down image’ initially”.
d. Then, in the “Elements” box, click the name “skills” to select it.
e. At the bottom of the window, check the box for “Show ‘down image’ initially”.
f. Click OK.
g. Your Skills button will now show the alternate button color when a visitor is on that
page, which lets them know where they are in your entire site.
3. To add the list of “Online Learning Mastery Skills”:
a. Highlight all of the text that is leftover from the index.html page, and delete it
(including your picture). Leave the buttons and general page setup the same.
b. In a web browser, open the Mastery Skills list that is found in the syllabus:
http://web.uconn.edu/myoung/dlms.html
c. Highlight the list of skills, and *right*click. On the menu that appears, choose
“copy”.
d. Go back to Dreamweaver and *right*click in the text cell of your skills.html page.
Choose “paste” and the text will be copied over.
e. You can now use this page to keep track of which items you have completed, and use
it as a way of displaying the “proof” that you did something (i.e. insert a screenshot of
an email you composed with a PowerPoint presentation as an attachment).
f. You can also insert images of “Completed” and “Not complete” graphics, or simply
type the text “Completed” when you are done with an item.
4. To make a link point to an item (like a picture, Word Document, PDF, etc.):
a. Type some text that will be the clickable link (i.e. “Click here for a screenshot”)
b. Highlight the text.
c. At the bottom of the screen, click the folder next to “Link” and browse to your
“images” or “documents” folder to select the file.

Step 6: Editing the Media page
This will be a page where you can try out adding some media elements, like sound, interactive
animation, movies, etc.
1.
2.
3.
4.

Open the “media.html” page.
Rename the title of the page (i.e. “Kent Golden – Media”)
Delete the text and pictures left over from the index.html page.
Modify the Navigation Bar so that the “Media” button will show as pressed (and the others
are not pressed).
5. To insert a sound or video file:
a. Click in the document where you would like the media player to appear.
b. Click the “Insert” menu option, then “media”, then “plugin”.
c. Browse for the MP3, WAV, or MOV file you want and select it.
d. Click OK to any warning messages that pop up.
e. Once you have inserted the item, a small graphic will appear. Highlight the graphic,
and enlarge the size of it so that a visitor can access all of the player controls.
f. Save and test your page.
6. To insert a Flash object (animation or interactive movie):
a. Click in the document where you would like the Flash object to appear.
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b. Click the “Insert” menu option, then “media”, then “Flash”.
c. Browse for the Flash object you want (a .swf file) and select it.
7. To have a link open up another html page:
a. Type some text that you want to be your link (or insert a picture)
b. Highlight the text.
c. Click the folder icon next to the “Link” box, and browse for the html page you want.
d. Underneath the link box, click the arrow next to “Target”, and choose “_blank”. This
means that the target will open up in a separate blank window.

Step 7: Final Publishing steps
Once your site has all of your content and looks the way you want, you have the option of making it
easier for people to find your site. If you only want to share your site with friends, this step is not
necessary, but if you want a wider audience to find your site, it is important to add description and
keyword “meta tags”. Meta Tags allow search engines (like Yahoo!, Google, AOL, MSN, etc) to
“crawl” the description and keywords of your site, and put that information in their database for
people to find.
1. Open your index.html file.
2. In order to see the raw html code of your page, click the button for “Split” at the top.

3. Then click at the end of the line that has this text: <title>Kent Golden – Home</title>
4. Hit the Return or Enter key to create a blank line.
5. Click in the blank line you just created.
6. Click the “Insert” menu option and choose “Tag”
7. On the “Tag Chooser” window that appears, click the + next to “HTML tags”
8. Click “Page Composition” to highlight it
9. On the right panel, click “Meta” to highlight it, then click the “Insert” button.
10. In the “Name” box, choose “Description”
11. In the “Content” box, type a short one or twoline description of your site. This is the text
that appears when someone does a Search Engine query and sees a list of sites to choose
from.
Example: “Welcome to Kent Golden’s EdTech website. Here you can see my
online eportfolio and view my contact information.”
12. Hit the OK button and the meta tag will appear in your raw html code.
13. You can now continue to add the remaining “keywords” meta tag in the “Tag Chooser”
14. Make sure “Meta” is still highlighted, and click “Insert” again.
15. In the “Name” box, choose “keywords”
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16. In the “Content” box, type some keywords for your website, separated by commas (no
spaces). These are the words that someone would type into a search engine to find your site.
Don’t put in more than 25 keywords.
Example: kent,golden,uconn,connecticut,educational,technology,eportfolio,web,design

Step 8: Putting all of the website files onto the remote server
If you haven’t done so already, you should put a copy of your entire website onto the server (so that
other people can see it).
1. To upload your website files from your local computer to the remote server (when you
are done editing it):
a. Open the file you want (i.e. skills.html, media.html, etc).
b. Click the “Site” menu at the top of the screen.
c. Click “Put”
d. A window will appear asking if you want to include dependant files. Choose “Yes”
so that all of the graphics and elements will also be copied to the server.
e. Note: In the future, if all of your graphics are already on the server and you only
made a change to the html page (like a spelling change), you can choose not to
include dependant files.
f. Note: An alternate way to upload files from your computer is to find the file on the
right side of your screen (where you see your folders), and *right*click it. You can
then choose “Put” from the menu that appears. This is useful if you want to upload a
picture that you edited, or a bunch of files at once.
g. This process must be repeated for every page you create, and must be repeated
whenever you make future changes to your website.

For more information on how to get your own domain name (i.e. www.yourname.com) and full
website (with email addresses and server storage space), go to: http://webhosting.yahoo.com
For more information on how to get your site listed better on a search engine, go to:
http://smallbusiness.yahoo.com/marketing/searchsub.php
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